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1 What's new in Acronis Backup 

1.1 What's new in Acronis Backup 12.5 
Important  These new features are available in on-premise deployments only. They will be propagated to 
cloud deployments in future releases. 

New features available in all on-premise deployments 

Backup 

Á A new backup format (p. 81) that increases the backup speed and reduces the size of backups 

Á Up to five locations for replication in a backup plan (p. 74) 

Á Conversion to a virtual machine in a backup plan (p. 72) 

Á Schedule by events (p. 65) 

Á Setting conditions for backup plan execution (p. 66) 

Á Predefined Grandfather-Father-Son (GFS) backup scheme (p. 63) 

Á SFTP as a backup location (p. 59) 

Á Default backup options stored on the management server (p. 231) 

Á Selection of the backup method (full or incremental) when starting a backup manually (p. 75) 

Á Backup options: 

Á Email notifications (p. 85): 

Á Specify the email notifications subject 

Á Notifications are now based on alerts instead of backup activity results. You can 
customize the list of alerts that trigger a notification. 

Á Backup file name (p. 78) 

Á Backup start conditions (p. 83) 

Recovery 

Á Manual disk mapping. The capability to recover individual disks or volumes (p. 101). 

Bootable media 

Á Startup Recovery Manager (p. 146) 

Applications 

Á Backing up Microsoft Exchange Server mailboxes (p. 161) 

Virtualization 

Á The capability to assign a virtual machine to a specific agent (p. 191) (VM binding) 

Operations with backups 

Á Mounting volumes in the read/write mode (p. 121) 

Á ASign allows a backed-up file to be signed by several people (p. 112) 

Notifications and alerts 

Á The capability to configure the severity of an alert (via the configuration file) (p. 200) 

Á Device status is now derived from alerts instead of backup activity results. This covers a wider 
range of events, for example, missed backups or ransomware activities. 
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Acronis Active Protection 

Á Proactive protection from ransomware by detecting suspicious processes (p. 174) 

Usability improvements 

Á Dashboard - a customizable set of more than 20 widgets that are updated in real time (p. 197) 

Á A new section in the UI shows all backup plans and other plans (p. 123) 

Á The capability to set an encryption password in Backup Monitor (p. 70) 

New features available with the Advanced licenses only 

Administering 

Á Customizable reports that can be sent or saved on a schedule (p. 198) 

Á Roles on the management server: create units and assign administrators to them (p. 232) 

Á Group management: built-in and custom groups of devices (p. 201) 

Á Acronis Notary: prove that a file is authentic and unchanged since it was backed up (p. 71) 

New backup locations 

Á Acronis Storage Node with deduplication (p. 223) 

Á Support for tape devices (p. 206) 

Bootable media 

Á Working with bootable media via the backup console (p. 144) 

Á Automated backup and recovery by execution of a predefined or custom script (p. 132) 

Á PXE Server for network boot (p. 147) 

Applications 

Á Support for Database Availability Groups (DAG) in Microsoft Exchange Server (p. 158) 

Á Support for AlwaysOn Availability Group (AAG) in Microsoft SQL Server (p. 157) 

Á Protecting Oracle Database (p. 174) 

Virtualization 

Á Backing up ESXi virtual machines from NetApp hardware snapshots (p. 186) 

Á Backing up Citrix XenServer, Red Hat Virtualization (RHV/RHEV), Kernel-based Virtual Machines 
(KVM), and Oracle virtual machines (by installing an agent into the guest system) (p. 11) 

Operations with backups 

Á Conversion to a virtual machine, validation, replication, and retention of backups can be 
performed on a schedule by a dedicated agent (p. 124) 

Á Cataloging - a separate catalog service enables search throughout all backups in managed 
locations (p. 228) 

 

1.2 What's new in Update 1 
Á Support for Citrix XenServer 7.0, 7.1, and 7.2 (p. 18) 

Á Support for Debian 8.6, 8.7, 8.8, 9, and Ubuntu 17.04 

Á Support for Windows Storage Server 2016 

Á Mass deployment and upgrade utility for unattended agent deployment.  

For information about how to use this utility, refer to the following Acronis Knowledge Base 
article: https://kb.acronis.com/content/60137 
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2 Installation 

2.1 Installation overview 
Acronis Backup supports two methods of deployment: on-premise and cloud. The main difference 
between them is the location of Acronis Backup Management Server.  

Acronis Backup Management Server is the central point for managing all of your backups. With the 
on-premise deployment, it is installed in your local network; with the cloud deployment, it is located 
in one of the Acronis data centers. The web interface to this server is named a backup console. 

Both types of deployment require that a backup agent is installed on each machine that you want to 
back up. The supported types of storage are also the same. The cloud storage space is sold separately 
from the Acronis Backup licenses. 

On-premise deployment 

On-premise deployment means that all of the product components are installed in your local 
network. This is the only deployment method available with a perpetual license. Also, you have to 
use this method if your machines are not connected to the Internet. 

 

Management server location 

You can install the management server on a machine running either Windows or Linux.  

Installation in Windows is recommended because you will be able to deploy agents to other 
machines from the management server. With the Advanced license, it is possible to create 
organizational units and add administrators to them. This way, you can delegate backup 
management to other people whose access permissions will be strictly limited to the corresponding 
units. 
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Installation in Linux is recommended in a Linux-only environment. You will need to install an agent 
locally on the machines that you want to back up. 

Cloud deployment 

Cloud deployment means that the management server is located in one of the Acronis data centers. 
The benefit of this approach is that you do not need to maintain the management server in your local 
network. You can think of Acronis Backup as of a backup service provided to you by Acronis.  

Access to the account server enables you to create user accounts, set service usage quotas for them, 
and create groups of users (units) to reflect the structure of your organization. Every user can access 
the backup console, download the required agent, and install it on their machines in minutes.  

Administrator accounts can be created at the unit or organization level. Each account has a view 
scoped to their area of control. Users have access only to their own backups.  

 

The following table summarizes differences between the on-premise and cloud deployments. 
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On-premise deployment Cloud deployment 

Á On-premise management server 

Á Unit and account management with the Advanced 
license only 

Á Both subscription and perpetual licenses can be used 

Á Agent for VMware (Virtual Appliance) and Agent for 
VMware (Windows) 

Á WAN optimization for replication of virtual machines 
(replica seeding) 

Á Bootable Media Builder 

Á Backup and disk management in bootable media 

Á Upgrade from previous versions of Acronis Backup, 
including Acronis Backup for VMware 

Á Participation in the Acronis Customer Experience 
Program 

Á Features introduced in version 12.5, which affects only 
on-premise deployments. See "What's new in Acronis 
Backup 12.5" (p. 7). 

Á Unit and account management 

Á A subscription license is required 

Á No Agent for VMware (Virtual Appliance) 

Á Mobile backup to cloud 

 

2.2 Components 

Agents 

Agents are applications that perform data backup, recovery, and other operations on the machines 
managed by Acronis Backup. 

Choose an agent, depending on what you are going to back up. The following table summarizes the 
information, to help you decide. 

Note that Agent for Windows is installed along with Agent for Exchange, Agent for SQL, Agent for 
Active Directory, and Agent for Oracle. If you install, for example, Agent for SQL, you also will be able 
to back up the entire machine where the agent is installed. 

What are you going to 
back up? 

Which agent to install? Where to install it? 
Agent availability 

On-prem Cloud 

Physical machines 

Disks, volumes, and files 
on physical machines 
running Windows 

Agent for Windows 

On the machine that will be backed up. 

+ + 

Disks, volumes, and files 
on physical machines 
running Linux 

Agent for Linux + + 

Disks, volumes, and files 
on physical machines 
running OS X 

Agent for Mac + + 

Applications 
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What are you going to 
back up? 

Which agent to install? Where to install it? 
Agent availability 

On-prem Cloud 

SQL databases Agent for SQL On the machine running Microsoft SQL 
Server. 

+ + 

Exchange databases and 
mailboxes 

Agent for Exchange 

On the machine running the Mailbox role 
of Microsoft Exchange Server. 

If only mailbox backup is required, the 
agent can be installed on any Windows 
machine that has network access to the 
machine running the Client Access role of 
Microsoft Exchange Server. 

+ 

+  
No 

mailbox 
backup 

Microsoft Office 365 
mailboxes 

Agent for Office 365 On a Windows machine that is connected 
to the Internet. 

+ + 

Machines running Active 
Directory Domain 
Services 

Agent for Active Directory On the domain controller. + + 

Machines running Oracle 
Database 

Agent for Oracle On the machine running Oracle Database + ς 

Virtual machines 

VMware ESXi virtual 
machines  

Agent for VMware 
(Windows) 

On a Windows machine that has network 
access to vCenter Server and to the 
virtual machine storage.* 

+ + 

Agent for VMware 
(Virtual Appliance) 

On the ESXi host. + ς 

Hyper-V virtual 
machines 

Agent for Hyper-V On the Hyper-V host. + + 

Virtual machines hosted 
on Windows Azure 

The same as for physical 
machines** 

On the machine that will be backed up. 

+ + 

Virtual machines hosted 
on Amazon EC2 

+ + 

Citrix XenServer virtual 
machines 

+***  + 

Red Hat Virtualization 
(RHV/RHEV) virtual 
machines 

Kernel-based Virtual 
Machines (KVM) 

Oracle virtual machines 

Mobile devices 

Mobile devices running 
Android 

Mobile app for Android 

On the mobile device that will be backed 
up. 

ς + 

Mobile devices running 
iOS 

Mobile app for iOS ς + 
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*If your ESXi uses a SAN attached storage, install the agent on a machine connected to the same SAN. The 
agent will back up the virtual machines directly from the storage rather than via the ESXi host and LAN. For 
detailed instructions, refer to "LAN-free backup" (p. 183). 

**A virtual machine is considered virtual if it is backed up by an external agent. If an agent is installed in the 
guest system, the backup and recovery operations are the same as with a physical machine. Nevertheless, the 
machine is counted as virtual when you set quotas for the number of machines in a cloud deployment. 

***With an Acronis Backup Advanced Virtual Host license, these virtual machines are considered as virtual (per 
host licensing is used). With an Acronis Backup Virtual Host license, these machines are considered as physical 
(per machine licensing is used). 

Other components 

Component Function Where to install it? 
Availability 

On-prem Cloud 

Management Server Manages the agents. 
Provides the web 
interface to users. 

On a machine running Windows or Linux. + ς 

Monitoring Service Provides the dashboard 
and reporting 
functionality. 

On the machine running the 
management server. 

+ ς 

Bootable Media Builder Creates bootable media. On a machine running Windows or Linux. + ς 

Backup Monitor Enables users to monitor 
backups outside the web 
interface. 

On a machine running Windows or OS X. + + 

Command-Line Tool Provides the 
command-line interface. 

On a machine running Windows or Linux. + + 

Storage Node Stores backups. Is 
required for cataloging 
and deduplication. 

On a machine running Windows. + ς 

Catalog Service Performs cataloging of 
backups on storage 
nodes. 

On a machine running Windows. + ς 

PXE Server Enables booting machines 
into bootable media 
through the network. 

On a machine running Windows. + ς 

 

2.3 Software requirements 

2.3.1 Supported web browsers 

The web interface supports the following web browsers: 

Á Google Chrome 29 or later 

Á Mozilla Firefox 23 or later 

Á Opera 16 or later 

Á Windows Internet Explorer 10 or later 

Á Microsoft Edge 25 or later 

Á Safari 8 or later running in the OS X and iOS operating systems 
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In other web browsers (including Safari browsers running in other operating systems), the user 
interface might be displayed incorrectly or some functions may be unavailable. 
 

2.3.2 Supported operating systems and environments 

2.3.2.1 Agents 

Agent for Windows 

Windows XP Professional SP3 (x86, x64)  

Windows Server 2003 SP1/2003 R2 and later ς Standard and Enterprise editions (x86, x64) 

Windows Small Business Server 2003/2003 R2 

Windows Vista ς all editions 

Windows Server 2008 ς Standard, Enterprise, Datacenter, and Web editions (x86, x64) 

Windows Small Business Server 2008 

Windows 7 ς all editions 

Windows Server 2008 R2 ς Standard, Enterprise, Datacenter, Foundation, and Web editions 

Windows MultiPoint Server 2010/2011/2012 

Windows Small Business Server 2011 ς all editions 

Windows 8/8.1 ς all editions (x86, x64), except for the Windows RT editions 

Windows Server 2012/2012 R2 ς all editions 

Windows Storage Server 2003/2008/2008 R2/2012/2012 R2/2016 

Windows 10 ς Home, Pro, Education, Enterprise, and IoT Enterprise editions 

Windows Server 2016 ς all installation options, except for Nano Server 

Agent for SQL, Agent for Exchange (for database backup and application-aware 
backup), Agent for Active Directory 

Each of these agents can be installed on a machine running any operating system listed 
above and a supported version of the respective application. 

Agent for Exchange (for mailbox backup) 

This agent can be installed on a machine with or without Microsoft Exchange Server. 

Windows Server 2008 ς Standard, Enterprise, Datacenter, and Web editions (x86, x64) 

Windows Small Business Server 2008 

Windows 7 ς all editions 

Windows Server 2008 R2 ς Standard, Enterprise, Datacenter, Foundation, and Web editions 

Windows MultiPoint Server 2010/2011/2012 

Windows Small Business Server 2011 ς all editions 

Windows 8/8.1 ς all editions (x86, x64), except for the Windows RT editions 

Windows Server 2012/2012 R2 ς all editions 

Windows Storage Server 2008/2008 R2/2012/2012 R2 

Windows 10 ς Home, Pro, Education, and Enterprise editions 

Windows Server 2016 ς all installation options, except for Nano Server 

Agent for Office 365 

Windows Server 2008 ς Standard, Enterprise, Datacenter, and Web editions (x64 only) 
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Windows Small Business Server 2008 

Windows Server 2008 R2 ς Standard, Enterprise, Datacenter, Foundation, and Web editions 

Windows Small Business Server 2011 ς all editions 

Windows 8/8.1 ς all editions (x64 only), except for the Windows RT editions 

Windows Server 2012/2012 R2 ς all editions 

Windows Storage Server 2008/2008 R2/2012/2012 R2/2016 (x64 only) 

Windows 10 ς Home, Pro, Education, and Enterprise editions (x64 only) 

Windows Server 2016 ς all installation options (x64 only), except for Nano Server 

Agent for Oracle 

Windows Server 2008 ς Standard, Enterprise, Datacenter, and Web editions (x86, x64) 

Windows Server 2012 ς Standard, Enterprise, Datacenter, and Web editions (x86, x64) 

Agent for Linux 

Linux with kernel from 2.6.9 to 4.9 and glibc 2.3.4 or later 

Various x86 and x86_64 Linux distributions, including: 

Red Hat Enterprise Linux 4.x, 5.x, 6.x, 7.0, 7.1, 7.2, 7.3 

Ubuntu 9.10, 10.04, 10.10, 11.04, 11.10, 12.04, 12.10, 13.04, 13.10, 14.04, 14.10, 15.04, 
15.10, 16.04, 16.10, 17.04 

Fedora 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24 

SUSE Linux Enterprise Server 10 and 11 

SUSE Linux Enterprise Server 12 ς supported on file systems, except for Btrfs 

Debian 4, 5, 6, 7.0, 7.2, 7.4, 7.5, 7.6, 7.7, 8.0, 8.1, 8.2, 8.3, 8.4, 8.5, 8.6, 8.7, 8.8, 9 

CentOS 5.x, 6.x, 7, 7.1, 7.2, 7.3 

Oracle Linux 5.x, 6.x, 7.0, 7.1, 7.2, 7.3 ς both Unbreakable Enterprise Kernel and Red Hat 
Compatible Kernel 

CloudLinux 5.x, 6.x, 7, 7.1 

ClearOS 5.x, 6.x, 7, 7.1 

Before installing the product on a system that does not use RPM Package Manager, such as 
an Ubuntu system, you need to install this manager manually; for example, by running the 
following command (as the root user): apt - get install rpm  

Agent for Mac 

OS X Mavericks 10.9 

OS X Yosemite 10.10 

OS X El Capitan 10.11 

macOS Sierra 10.12 ς Apple File System (APFS) is not supported 

Agent for VMware (Virtual Appliance) 

This agent is delivered as a virtual appliance for running on an ESXi host. 

VMware ESXi 4.1, 5.0, 5.1, 5.5, 6.0, 6.5 

Agent for VMware (Windows) 

This agent is delivered as a Windows application for running in any operating system listed 
above for Agent for Windows with the following exceptions: 

Á 32-bit operating systems are not supported. 
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Á Windows XP, Windows Server 2003/2003 R2, and Windows Small Business Server 
2003/2003 R2 are not supported. 

Agent for Hyper-V 

Windows Server 2008 (x64 only) with Hyper-V 

Windows Server 2008 R2 with Hyper-V 

Microsoft Hyper-V Server 2008/2008 R2 

Windows Server 2012/2012 R2 with Hyper-V 

Microsoft Hyper-V Server 2012/2012 R2 

Windows 8, 8.1 (x64 only) with Hyper-V 

Windows 10 ς Pro, Education, and Enterprise editions with Hyper-V 

Windows Server 2016 with Hyper-V ς all installation options, except for Nano Server 

Microsoft Hyper-V Server 2016 
 

2.3.2.2 Management Server (for on-premise deployment only) 

In Windows 

Windows Server 2008 ς Standard, Enterprise, and Datacenter editions (x86, x64) 

Windows Small Business Server 2008 

Windows 7 ς all editions (x86, x64) 

Windows Server 2008 R2 ς Standard, Enterprise, Datacenter, and Foundation editions 

Windows MultiPoint Server 2010/2011/2012 

Windows Small Business Server 2011 ς all editions 

Windows 8/8.1 ς all editions (x86, x64), except for the Windows RT editions 

Windows Server 2012/2012 R2 ς all editions 

Windows Storage Server 2008/2008 R2/2012/2012 R2/2016 

Windows 10 ς Home, Pro, Education, Enterprise, and IoT Enterprise editions 

Windows Server 2016 ς all installation options, except for Nano Server 

In Linux 

Linux with kernel from 2.6.18 to 4.9 and glibc 2.3.4 or later 

Various x86_64 Linux distributions, including: 

Red Hat Enterprise Linux 4.x, 5.x, 6.x, 7.0, 7.1, 7.2, 7.3 

Ubuntu 9.10, 10.04, 10.10, 11.04, 11.10, 12.04, 12.10, 13.04, 13.10, 14.04, 14.10, 15.04, 
15.10, 16.04, 16.10, 17.04 

Fedora 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24 

SUSE Linux Enterprise Server 10, 11, 12 

Debian 4, 5, 6, 7.0, 7.2, 7.4, 7.5, 7.6, 7.7, 8.0, 8.1, 8.2, 8.3, 8.4, 8.5, 8.6, 8.7, 8.8, 9 

CentOS 5.x, 6.x, 7, 7.1, 7.2, 7.3 

Oracle Linux 5.x, 6.x, 7.0, 7.1, 7.2, 7.3 ς both Unbreakable Enterprise Kernel and Red Hat 
Compatible Kernel 

CloudLinux 5.x, 6.x, 7, 7.1 
 

2.3.2.3 Storage Node (for on-premise deployment only) 
Windows Server 2008 ς Standard, Enterprise, and Datacenter editions (x64 only) 
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Windows Small Business Server 2008 

Windows 7 ς all editions (x64 only) 

Windows Server 2008 R2 ς Standard, Enterprise, Datacenter, and Foundation editions 

Windows MultiPoint Server 2010/2011/2012 

Windows Small Business Server 2011 ς all editions 

Windows 8/8.1 ς all editions (x64 only), except for the Windows RT editions 

Windows Server 2012/2012 R2 ς all editions 

Windows Storage Server 2008/2008 R2/2012/2012 R2/2016 

Windows 10 ς Home, Pro, Education, and Enterprise editions 

Windows Server 2016 ς all installation options, except for Nano Server 
 

2.3.3 Supported Microsoft SQL Server versions 
Á Microsoft SQL Server 2016 

Á Microsoft SQL Server 2014 

Á Microsoft SQL Server 2012 

Á Microsoft SQL Server 2008 R2 

Á Microsoft SQL Server 2008 

Á Microsoft SQL Server 2005 
 

2.3.4 Supported Microsoft Exchange Server versions 
Á Microsoft Exchange Server 2016 ς all editions. 

Á Microsoft Exchange Server 2013 ς all editions, Cumulative Update 1 (CU1) and later. 

Á Microsoft Exchange Server 2010 ς all editions, all service packs. Mailbox backup and granular 
recovery from database backups are supported starting with Service Pack 1 (SP1). 

Á Microsoft Exchange Server 2007 ς all editions, all service packs. Mailbox backup and granular 
recovery from database backups are not supported. 

 

2.3.5 Supported Microsoft SharePoint versions 

Acronis Backup 12.5 supports the following Microsoft SharePoint versions: 

Á Microsoft SharePoint 2013 

Á Microsoft SharePoint Server 2010 SP1 

Á Microsoft SharePoint Foundation 2010 SP1 

Á Microsoft Office SharePoint Server 2007 SP2* 

Á Microsoft Windows SharePoint Services 3.0 SP2* 

*In order to use SharePoint Explorer with these versions, you need a SharePoint recovery farm to attach the 
databases to. 

The backups or databases from which you extract data must originate from the same SharePoint 
version as the one where SharePoint Explorer is installed. 
 

2.3.6 Supported Oracle Database versions 
Á Oracle Database version 11g, all editions  

Á Oracle Database version 12c, all editions.  
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Only single-instance configurations are supported. 
 

2.3.7 Supported virtualization platforms 

The following table summarizes how various virtualization platforms are supported. 

Platform Backup at a hypervisor 
level (agentless backup) 

Backup from inside a 
guest OS 

VMware 

VMware vSphere versions: 4.1, 5.0, 5.1, 5.5, 
6.0, 6.5 

VMware vSphere editions:  

VMware vSphere Essentials* 

VMware vSphere Essentials Plus* 

VMware vSphere Standard* 

VMware vSphere Advanced 

VMware vSphere Enterprise 

VMware vSphere Enterprise Plus 

+ + 

VMware vSphere Hypervisor (Free ESXi)**  + 

VMware Server (VMware Virtual server) 

VMware Workstation 

VMware ACE 

VMware Player 

 + 

Microsoft 

Windows Server 2008 (x64) with Hyper-V 

Windows Server 2008 R2 with Hyper-V 

Microsoft Hyper-V Server 2008/2008 R2 

Windows Server 2012/2012 R2 with Hyper-V 

Microsoft Hyper-V Server 2012/2012 R2 

Windows 8, 8.1 (x64) with Hyper-V 

Windows 10 with Hyper-V 

Windows Server 2016 with Hyper-V ς all 
installation options, except for Nano Server 

Microsoft Hyper-V Server 2016 

+ + 

Microsoft Virtual PC 2004 and 2007 

Windows Virtual PC 
 + 

Microsoft Virtual Server 2005  + 

Citrix 

Citrix XenServer 4.1.5, 5.5, 5.6, 6.0, 6.1, 6.2, 6.5, 
7.0, 7.1, 7.2 

 
Only fully virtualized 

(aka HVM) guests 
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Platform Backup at a hypervisor 
level (agentless backup) 

Backup from inside a 
guest OS 

Red Hat and Linux 

Red Hat Enterprise Virtualization (RHEV) 2.2, 
3.0, 3.1, 3.2, 3.3, 3.4, 3.5, 3.6 

Red Hat Virtualization (RHV) 4.0 

 + 

Kernel-based Virtual Machines (KVM)  + 

Parallels 

Parallels Workstation  + 

Parallels Server 4 Bare Metal  + 

Oracle 

Oracle VM Server 3.0 and 3.3  + 

Oracle VM VirtualBox 4.x  + 

Amazon 

Amazon EC2 instances  + 

Microsoft Azure 

Azure virtual machines  + 

* In these editions, the HotAdd transport for virtual disks is supported on vSphere 5.0 and later. On version 4.1, 
backups may run slower. 

** Backup at a hypervisor level is not supported for vSphere Hypervisor because this product restricts access to 
Remote Command Line Interface (RCLI) to read-only mode. The agent works during the vSphere Hypervisor 
evaluation period while no serial key is entered. Once you enter a serial key, the agent stops functioning. 

Limitations 

Á Fault tolerant machines 

Agent for VMware backs up a fault tolerant machine only if fault tolerance was enabled in 
VMware vSphere 6.0 and later. If you upgraded from an earlier vSphere version, it is enough to 
disable and enable fault tolerance for each machine. If you are using an earlier vSphere version, 
install an agent in the guest operating system. 

Á Independent disks and RDM 

Agent for VMware does not back up Raw Device Mapping (RDM) disks in physical compatibility 
mode or independent disks. The agent skips these disks and adds warnings to the log. You can 
avoid the warnings by excluding independent disks and RDMs in physical compatibility mode 
from the backup plan. If you want to back up these disks or data on these disks, install an agent 
in the guest operating system. 

Á Pass-through disks 

Agent for Hyper-V does not back up pass-through disks. During backup, the agent skips these 
disks and adds warnings to the log. You can avoid the warnings by excluding pass-through disks 
from the backup plan. If you want to back up these disks or data on these disks, install an agent 
in the guest operating system. 

Á Encrypted virtual machines (introduced in VMware vSphere 6.5) 
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Á Encrypted virtual machines are backed up in an unencrypted state. If encryption is critical to 
you, enable encryption of backups when creating a backup plan (p. 70). 

Á Recovered virtual machines are always unencrypted. You can manually enable encryption 
after the recovery is complete. 

Á If you back up encrypted virtual machines, we recommend that you also encrypt the virtual 
machine where Agent for VMware is running. Otherwise, operations with encrypted 
machines may be slower than expected. Apply the VM Encryption Policy to the agent's 
machine by using vSphere Web Client. 

Á Encrypted virtual machines will be backed up via LAN, even if you configure the SAN 
transport mode for the agent. The agent will fall back on the NBD transport because VMware 
does not support SAN transport for backing up encrypted virtual disks. 

Á Secure Boot (introduced in VMware vSphere 6.5) 

Secure Boot is disabled after a virtual machine is recovered as a new virtual machine. You can 
manually enable this option after the recovery is complete. 

 

2.3.8 Linux packages 

To add the necessary modules to the Linux kernel, the setup program needs the following Linux 
packages: 

Á The package with kernel headers or sources. The package version must match the kernel version. 

Á The GNU Compiler Collection (GCC) compiler system. The GCC version must be the one with 
which the kernel was compiled. 

Á The Make tool. 

Á The Perl interpreter. 

The names of these packages vary depending on your Linux distribution. 

In Red Hat Enterprise Linux, CentOS, and Fedora, the packages normally will be installed by the setup 
program. In other distributions, you need to install the packages if they are not installed or do not 
have the required versions. 

Are the required packages already installed? 

To check whether the packages are already installed, perform these steps: 

1. Run the following command to find out the kernel version and the required GCC version: 

cat /proc/version  

This command returns lines similar to the following: Linux version 2.6.35.6  and gcc 
version 4.5.1  

2. Run the following command to check whether the Make tool and the GCC compiler are installed: 

make - v 
gcc - v 

For gcc, ensure that the version returned by the command is the same as in the gcc version  in 
step 1. For make, just ensure that the command runs. 

3. Check whether the appropriate version of the packages for building kernel modules is installed: 

Á In Red Hat Enterprise Linux, CentOS, and Fedora, run the following command: 

yum list installed | grep kernel - devel  

Á In Ubuntu, run the following commands: 
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dpkg -- get - selections | grep linux - headers  
dpkg -- get - selections | grep linux - image 

In either case, ensure that the package versions are the same as in Linux version  in step 1. 

4. Run the following command to check whether the Perl interpreter is installed: 

perl -- version  

If you see the information about the Perl version, the interpreter is installed. 

Installing the packages from the repository 

The following table lists how to install the required packages in various Linux distributions. 

Linux 
distribution 

Package names How to install 

Red Hat 
Enterprise 
Linux 

 

kernel-devel 
gcc 
make 

The setup program will download and install the packages 
automatically by using your Red Hat subscription. 

perl Run the following command: 

yum install perl  

CentOS 

Fedora 

 

kernel-devel 
gcc 
make 

The setup program will download and install the packages 
automatically. 

perl Run the following command: 

yum install perl  

Ubuntu linux-headers 
linux-image 
gcc 
make 
perl 

Run the following commands: 

sudo apt - get update  
sudo apt - get install linux - headers - `uname - r`  
sudo apt - get install linux - image- `uname - r`  
sudo apt - get install gcc - <package version>  
sudo apt - get install make  
sudo apt - get install perl  

The packages will be downloaded from the distribution's repository and installed.  

For other Linux distributions, please refer to the distribution's documentation regarding the exact 
names of the required packages and the ways to install them. 

Installing the packages manually 

You may need to install the packages manually if: 

Á The machine does not have an active Red Hat subscription or Internet connection. 

Á The setup program cannot find the kernel-devel or gcc version corresponding to the kernel 
version. If the available kernel-devel is more recent than your kernel, you need to either update 
the kernel or install the matching kernel-devel version manually. 

Á You have the required packages on the local network and do not want to spend time for 
automatic search and downloading. 

Obtain the packages from your local network or a trusted third-party website, and install them as 
follows: 

Á In Red Hat Enterprise Linux, CentOS, or Fedora, run the following command as the root user: 

rpm - ivh PACKAGE_FILE1 PACKAGE_FILE2 PACKAGE_FILE3 
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Á In Ubuntu, run the following command: 

sudo dpkg - i PACKAGE_FILE1 PACKAGE_FILE2 PACKAGE_FILE3 

Example: Installing the packages manually in Fedora 14 

Follow these steps to install the required packages in Fedora 14 on a 32-bit machine: 

1. Run the following command to determine the kernel version and the required GCC version: 

cat /proc/version  

The output of this command includes the following: 

Linux version 2.6.35.6 - 45.fc14.i686  
gcc version 4.5.1  

2. Obtain the kernel-devel and gcc packages that correspond to this kernel version: 

kernel - devel - 2.6.35.6 - 45.fc14.i686.rpm  
gcc- 4.5.1 - 4.fc14.i686.rpm  

3. Obtain the make package for Fedora 14: 

make- 3.82 - 3.fc14.i686  

4. Install the packages by running the following commands as the root user: 

rpm - ivh kernel - devel - 2.6.35.6 - 45.fc14.i686.rpm  
rpm - ivh gcc - 4.5.1.fc14.i686.rpm  
rpm - ivh make - 3.82 - 3.fc14.i686  

You can specify all these packages in a single rpm command. Installing any of these packages may 
require installing additional packages to resolve dependencies. 

 

2.3.9 Compatibility with encryption software  

There are no limitations on backing up and recovering data that is encrypted by file-level encryption 
software. 

Disk-level encryption software encrypts data on the fly. This is why data contained in the backup is 
not encrypted. Disk-level encryption software often modifies system areas: boot records, or partition 
tables, or file system tables. These factors affect disk-level backup and recovery, the ability of the 
recovered system to boot and access to Secure Zone. 

You can back up the data encrypted by the following disk-level encryption software: 

Á Microsoft BitLocker Drive Encryption 

Á McAfee Endpoint Encryption 

Á PGP Whole Disk Encryption. 

To ensure reliable disk-level recovery, follow the common rules and software-specific 
recommendations. 

Common installation rule 

The strong recommendation is to install the encryption software before installing the backup agents. 

The way of using Secure Zone 

Secure Zone must not be encrypted with disk-level encryption. This is the only way to use Secure 
Zone: 

1. Install the encryption software; then, install the agent. 

2. Create Secure Zone. 
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3. Exclude Secure Zone when encrypting the disk or its volumes. 

Common backup rule 

You can do a disk-level backup in the operating system. Do not try to back up using bootable media. 

Software-specific recovery procedures 

Microsoft BitLocker Drive Encryption 

To recover a system that was encrypted by BitLocker: 

1. Boot from the bootable media. 

2. Recover the system. The recovered data will be unencrypted. 

3. Reboot the recovered system. 

4. Turn on BitLocker.  

If you only need to recover one partition of a multi-partitioned disk, do so under the operating 
system. Recovery under bootable media may make the recovered partition undetectable for 
Windows. 

McAfee Endpoint Encryption and PGP Whole Disk Encryption 

You can recover an encrypted system partition by using bootable media only. 

If the recovered system fails to boot, rebuild Master Boot Record as described in the following 
Microsoft knowledge base article: https://support.microsoft.com/kb/2622803 
 

2.4 System requirements 
The following table summarizes disk space and memory requirements for typical installation cases. 
The installation is performed with the default settings. 

Components to be installed Occupied disk space 
Minimum memory 

consumption 

Agent for Windows 850 MB 150 MB 

Agent for Windows and one of the following agents: 

Á Agent for SQL 

Á Agent for Exchange 

950 MB 170 MB 

Agent for Windows and one of the following agents: 

Á Agent for VMware (Windows) 

Á Agent for Hyper-V 

1170 MB 180 MB 

Agent for Office 365 500 MB 170 MB 

Agent for Linux 720 MB 130 MB 

Agent for Mac 500 MB 150 MB 

For on-premise deployments only 

Management Server in Windows 1.7 GB 200 MB 

Management Server in Linux 0.6 GB 200 MB 

Management Server and Agent for Windows 2.4 GB 360 MB 
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Management Server and agents on a machine running 
Windows, Microsoft SQL Server, Microsoft Exchange Server, and 
Active Directory Domain Services 

3.35 GB 400 MB 

Management Server and Agent for Linux 1.2 GB 340 MB 

Storage Node and Agent for Windows  

Á 64-bit platform only 

Á To use deduplication, minimum 8 GB of RAM are required. 
For more information, see "Deduplication best practices" (p. 
226). 

1.1 GB 330 MB 

While backing up, an agent typically consumes about 350 MB of memory (measured during a 500-GB 
volume backup). The peak consumption may reach 2 GB, depending on the amount and type of data 
being processed. 

Bootable media or a disk recovery with a reboot requires at least 1 GB of memory.  

A management server with one registered machine consumes 200 MB of memory. Each of the newly 
registered machines adds about 4 MB. Thus, a server with 100 registered machines consumes 
approximately 600 MB above the operating system and running applications. The maximum number 
of registered machines is 900-1000. This limitation originates from the management server's 
embedded SQLite. 

You can overcome this limitation by specifying an external Microsoft SQL Server instance during the 
management server installation. With an external SQL database, up to 2000 machines can be 
registered without significant performance degradation. 
 

2.5 Supported file systems 
A backup agent can back up any file system that is accessible from the operating system where the 
agent is installed. For example, Agent for Windows can back up and recover an ext4 file system if the 
corresponding driver is installed in Windows.  

The following table summarizes the file systems that can be backed up and recovered. The 
limitations apply to both the agents and bootable media. 

File system 

Supported by 

Limitations 
Agents 

Win-PE 
bootable 
media  

Linux-based 
bootable media 

Mac bootable 
media 

FAT16/32 

All agents 

+ + + 

No limitations 

NTFS + + + 

ext2/ext3/ext4  + + - 

HFS+ Agent for Mac - - + 

JFS Agent for Linux - + - 
Files cannot be excluded 

from a disk backup 
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File system 

Supported by 

Limitations 
Agents 

Win-PE 
bootable 
media  

Linux-based 
bootable media 

Mac bootable 
media 

ReiserFS3 - + - 

ReiserFS4 - + - Á Files cannot be 
excluded from a disk 
backup 

Á Volumes cannot be 
resized during a 
recovery 

ReFS 

All agents 

+ + + 

XFS + + + 

Linux swap Agent for Linux - + - No limitations 

The software automatically switches to the sector-by-sector mode when backing up drives with 
unrecognized or unsupported file systems. A sector-by-sector backup is possible for any file system 
that: 

Á is block-based 

Á spans a single disk 

Á has a standard MBR/GPT partitioning scheme 

If the file system does not meet these requirements, the backup fails. 
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2.6 On-premise deployment 
An on-premise deployment includes a number of software components that are described in the 
"Components" (p. 11) section. The diagram below illustrates the component interaction and the 
ports required for this interaction. The arrow direction shows which component initiates a 
connection. 

 
 

2.6.1 Installing the management server 

2.6.1.1 Installation in Windows 

To install the management server 

1. Log on as an administrator and start the Acronis Backup setup program. 

2. [Optional] To change the language the setup program is displayed in, click Setup language. 

3. Accept the terms of the license agreement and select whether the machine will participate in the 
Acronis Customer Experience Program (CEP). 
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4. Leave the default setting Install a backup agent and Acronis Backup Management Server. 

 
5. Do any of the following: 

Á Click Install Acronis Backup.  

This is the easiest way to install the product. Most of the installation parameters will be set 
to their default values. 

The following components will be installed: 

Á Management Server 

Á Monitoring Service 

Á Agent for Windows 

Á Other agents (Agent for Hyper-V, Agent for Exchange, Agent for SQL, and Agent for 
Active Directory), if the respective hypervisor or application is detected on the machine 

Á Bootable Media Builder 

Á Command-Line Tool 

Á Backup Monitor 

Á Click Customize installation settings to configure the setup.  

You will be able to select the components to be installed and to specify additional 
parameters. For details, refer to "Customizing installation settings" (p. 27). 

Á Click Create .mst and .msi files for unattended installation to extract the installation 
packages. Review or modify the installation settings that will be added to the .mst file, and 
then click Generate. Further steps of this procedure are not required. 

If you want to deploy agents through Group Policy, refer to "Deploying agents through Group 
Policy" (p. 41). 

6. Proceed with the installation. 

7. After the installation completes, click Close. 
 

Customizing installation settings 

This section describes settings that can be changed during installation. 
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Common settings 

Á The components to be installed. 

Á The folder where the product will be installed. 

Á The accounts under which the services will run.  

You can choose one of the following: 

Á Use Service User Accounts (default for the agent service) 

Service User Accounts are Windows system accounts that are used to run services. The 
advantage of this setting is that the domain security policies do not affect these accounts' 
user rights. By default, the agent runs under the Local System account. 

Á Create a new account (default for the management server service and the storage node 
service) 

The account names will be Acronis Agent User, AMS User, and ASN User for the agent, 
management server, and the storage node services, respectively. 

Á Use the following account 

If you install the product on a domain controller, the setup program prompts you to specify 
existing accounts (or the same account) for each service. For security reasons, the setup 
program does not automatically create new accounts on a domain controller. 

Also, choose this setting if you want the management server to use an existing Microsoft SQL 
server installed on a different machine and use Windows Authentication for the SQL Server. 

If you chose the Create a new account or Use the following account option, ensure that the 
domain security policies do not affect the related accounts' rights. If an account is deprived of 
the user rights assigned during the installation, the component may work incorrectly or not work. 

Management server installation 

Á The database to be used by the management server.  

By default, the built-in SQLite database is used. You can select any edition of Microsoft SQL 
Server 2012, Microsoft SQL Server 2014, or Microsoft SQL Server 2016. The instance you choose 
can also be used by other programs. 

Before selecting an instance installed on another machine, ensure that SQL Server Browser 
Service and the TCP/IP protocol are enabled on that machine. For instructions on how to start 
SQL Server Browser Service, refer to: http://msdn.microsoft.com/en-us/library/ms189093.aspx. 
You can enable the TCP/IP protocol by using a similar procedure. 

Á The port that will be used by a web browser to access the management server (by default, 9877) 
and the port that will be used for communication between the product components (by default, 
7780). Changing the latter port after the installation will require re-registering of all of the 
components. 

Windows Firewall is configured automatically during the installation. If you use a different 
firewall, ensure that the ports are open for both incoming and outgoing requests through that 
firewall. 

Á Whether the agents and other components will access the management server by using its host 
name or the IP address.  

By default, the host name is specified. You may need to change this setting if DNS is unable to 
resolve the host name to the IP address, which results in a component registration failure. 

Agent installation 

Á Whether the agent will connect to the Internet through an HTTP proxy server, when backing up 
to and recovering from the cloud storage. 
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If a proxy server is required, specify its host name or IP address and the port number. 
 

2.6.1.2 Installation in Linux  

Preparation 

1. Before installing the product on a system that does not use RPM Package Manager, such as an 
Ubuntu system, you need to install this manager manually; for example, by running the following 
command (as the root user): apt - get install rpm . 

2. If you want to install Agent for Linux along with the management server, ensure that the 
necessary Linux packages (p. 20) are installed on the machine. 

Installation 

To install the management server 

1. As the root user, run the installation file. 

2. Accept the terms of the license agreement. 

3. [Optional] Select the components that you want to install.  

By default, the following components will be installed: 

Á Management Server 

Á Agent for Linux 

Á Bootable Media Builder 

4. Specify the port that will be used by a web browser to access the management server. The 
default value is 9877. 

5. Specify the port that will be used for communication between the product components. The 
default value is 7780. 

6. Click Next to proceed with the installation. 

7. After the installation completes, select Open web console, and then click Exit. The backup 
console will open in your default web browser. 

 

2.6.2 Adding machines via the web interface 

To start adding a machine to the management server, click All devices > Add. 

If the management server is installed in Linux, you will be asked to select the setup program based 
on the type of the machine that you want to add. Once the setup program is downloaded, run it 
locally on that machine. 

The operations described later in this section are possible if the management server is installed in 
Windows. In most cases, the agent will be silently deployed to the selected machine. 
 

2.6.2.1 Adding a machine running Windows 

Preparation 

1. For successful installation on a remote machine running Windows XP, the option Control panel > 
Folder options > View > Use simple file sharing must be disabled on that machine. 

For successful installation on a remote machine running Windows Vista or later, the option 
Control panel > Folder options > View > Use Sharing Wizard must be disabled on that machine. 

2. For successful installation on a remote machine that is not a member of an Active Directory 
domain, User Account Control (UAC) must be disabled (p. 30). 

3. File and Printer Sharing must be enabled on the remote machine. To access this option: 



30 Copyright © Acronis International GmbH, 2002-2017 

 

Á On a machine running Windows XP with Service Pack 2 or Windows 2003 Server: go to 
Control panel > Windows Firewall > Exceptions > File and Printer Sharing. 

Á On a machine running Windows Vista, Windows Server 2008, Windows 7, or later: go to 
Control panel > Windows Firewall > Network and Sharing Center > Change advanced 
sharing settings. 

4. Acronis Backup uses TCP ports 445 and 25001 for remote installation. Also, it uses TCP port 9876 
for remote installation and for communication between the components.  

Port 445 is automatically opened when you enable File and Printer Sharing. Ports 9876 and 
25001 are automatically opened through Windows Firewall. If you use a different firewall, make 
sure that these three ports are open (added to exceptions) for both incoming and outgoing 
requests. 

After the remote installation is complete, you can remove ports 445 and 25001 from exceptions. 
Port 25001 is automatically closed through Windows Firewall. Port 9876 needs to remain open. 

Adding the machine 

1. Click All devices > Add. 

2. Click Windows or the button that corresponds to the application that you want to protect. 
Depending on the button you click, one of the following options is selected: 

Á Agent for Windows 

Á Agent for Hyper-V 

Á Agent for SQL + Agent for Windows  

Á Agent for Exchange + Agent for Windows 

If you clicked Microsoft Exchange Server > Exchange mailboxes, and at least one Agent for 
Exchange is already registered, you are taken directly to step 5. 

Á Agent for Active Directory + Agent for Windows 

Á Agent for Office 365 

3. Specify the host name or IP address of the machine, and the credentials of an account with 
administrative privileges on that machine. 

4. Click Add. 

5. If you clicked Microsoft Exchange Server > Exchange mailboxes in step 2, specify the machine 
where the Client Access server role (CAS) of Microsoft Exchange Server is enabled. For more 
information, refer to "Mailbox backup" (p. 161). 

 

Requirements on User Account Control (UAC) 

On a machine that is running Windows Vista or later and is not a member of an Active Directory 
domain, centralized management operations (including remote installation) require that UAC be 
disabled. 

To disable UAC 

Do one of the following depending on the operating system: 

Á In a Windows operating system prior to Windows 8: 

Go to Control panel > View by: Small icons > User Accounts > Change User Account Control 
Settings, and then move the slider to Never notify. Then, restart the machine. 

Á In any Windows operating system: 

1. Open Registry Editor. 
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2. Locate the following registry key: 
HKEY_LOCAL_MACHINE\ Software\ Microsoft\ Windows\ CurrentVersion\ Policies\ System 

3. For the EnableLUA value, change the setting to 0. 

4. Restart the machine. 
 

2.6.2.2 Adding a machine running Linux 
1. Click All devices > Add. 

2. Click Linux. This will download the installation file. 

3. On the machine that you want to protect, run the setup program locally (p. 35). 
 

2.6.2.3 Adding a machine running OS X 
1. Click All devices > Add. 

2. Click Mac. This will download the installation file. 

3. On the machine that you want to protect, run the setup program locally (p. 35). 
 

2.6.2.4 Adding a vCenter or an ESXi host 

There are three methods of adding a vCenter or a stand-alone ESXi host to the management server:  

Á Deploying Agent for VMware (Virtual Appliance) (p. 31) 

This method is recommended in most cases. The virtual appliance will be automatically deployed 
to every host managed by the vCenter you specify. You can select the hosts and customize the 
virtual appliance settings. 

Á Installing Agent for VMware (Windows) (p. 32) 

You may want to install Agent for VMware on a physical machine running Windows for the 
purpose of an offloaded or LAN-free backup. The agent will be automatically deployed to the 
machine you specify. 

Á Offloaded backup 

Use if your production ESXi hosts are so heavily loaded that running the virtual appliances is 
not desirable. 

Á LAN-free backup 

If your ESXi uses a SAN attached storage, install the agent on a machine connected to the 
same SAN. The agent will back up the virtual machines directly from the storage rather than 
via the ESXi host and LAN. For detailed instructions, refer to "LAN-free backup" (p. 183). 

Á Registering an already installed Agent for VMware (p. 32) 

Use this method if you installed Agent for VMware (Windows) manually, deployed Agent for 
VMware (Virtual Appliance) from an OVF template (p. 35), or had to re-install the management 
server. 

 

Deploying Agent for VMware (Virtual Appliance) via the web interface 
1. Click All devices > Add. 

2. Click VMware ESXi. 

3. Select Deploy as a virtual appliance to each host of a vCenter. 

4. Specify the address and access credentials for the vCenter Server or stand-alone ESXi host. We 
recommend using an account that has the Administrator role assigned. Otherwise, provide an 
account with the necessary privileges (p. 193) on the vCenter Server or ESXi. 

5. [Optional] Click Settings to customize the deployment settings: 
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Á ESXi hosts that you want to deploy the agent to (only if a vCenter Server was specified in the 
previous step). 

Á The virtual appliance name. 

Á The datastore where the appliance will be located. 

Á The resource pool or vApp that will contain the appliance. 

Á The network that the virtual appliance's network adapter will be connected to. 

Á Network settings of the virtual appliance. You can choose DHCP auto configuration or specify 
the values manually, including a static IP address. 

6. Click Deploy. 
 

Installing Agent for VMware (Windows) 

Preparation 

Follow the preparatory steps described in the "Adding a machine running Windows" (p. 29) section. 

Installation 

1. Click All devices > Add. 

2. Click VMware ESXi. 

3. Select Remotely install on a machine running Windows. 

4. Specify the host name or IP address of the machine, and the credentials of an account with 
administrative privileges on that machine. Click Connect. 

5. Specify the address and credentials for the vCenter Server or stand-alone ESXi host, and then 
click Connect. We recommend using an account that has the Administrator role assigned. 
Otherwise, provide an account with the necessary privileges (p. 193) on the vCenter Server or 
ESXi. 

6. Click Install to install the agent. 
 

Registering an already installed Agent for VMware 

This section describes registering Agent for VMware via the web interface. 

Alternative registration methods: 

Á You can register Agent for VMware (Virtual Appliance) by specifying the management server in 
the virtual appliance UI. See step 3 under "Configuring the virtual appliance" in the "Deploying 
Agent for VMware (Virtual Appliance) from an OVF template" (p. 35) section. 

Á Agent for VMware (Windows) is registered during its local installation (p. 33). 

To register Agent for VMware 

1. Click All devices > Add. 

2. Click VMware ESXi. 

3. Select Register an already installed agent. 

4. If you register Agent for VMware (Windows), specify the host name or IP address of the machine 
where the agent is installed, and credentials of an account with administrative privileges on that 
machine. 

If you register Agent for VMware (Virtual Appliance), specify the host name or IP address of the 
virtual appliance, and credentials for the vCenter Server or the stand-alone ESXi host where the 
appliance is running. 

Click Connect. 
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5. Specify the host name or IP address of the vCenter Server or the ESXi host, and credentials to 
access it, and then click Connect. We recommend using an account that has the Administrator 
role assigned. Otherwise, provide an account with the necessary privileges (p. 193) on the 
vCenter Server or ESXi. 

6. Click Register to register the agent. 
 

2.6.3 Installing agents locally 

2.6.3.1 Installation in Windows 

To install Agent for Windows, Agent for Hyper-V, Agent for Exchange, Agent for SQL, or Agent 
for Active Directory 

1. Log on as an administrator and start the Acronis Backup setup program. 

2. [Optional] To change the language the setup program is displayed in, click Setup language. 

3. Accept the terms of the license agreement and select whether the machine will participate in the 
Acronis Customer Experience Program (CEP). 

4. Select Install a backup agent. 

5. Do any of the following: 

Á Click Install Acronis Backup.  

This is the easiest way to install the product. Most of the installation parameters will be set 
to their default values. 

The following components will be installed: 

Á Agent for Windows 

Á Other agents (Agent for Hyper-V, Agent for Exchange, Agent for SQL, and Agent for 
Active Directory), if the respective hypervisor or application is detected on the machine 

Á Bootable Media Builder 

Á Command-Line Tool 

Á Backup Monitor 

Á Click Customize installation settings to configure the setup.  

You will be able to select the components to be installed and to specify additional 
parameters. For details, refer to "Customizing installation settings" (p. 27). 

Á Click Create .mst and .msi files for unattended installation to extract the installation 
packages. Review or modify the installation settings that will be added to the .mst file, and 
then click Generate. Further steps of this procedure are not required. 

If you want to deploy agents through Group Policy, proceed as described in "Deploying 
agents through Group Policy" (p. 41). 

6. Specify the management server where the machine with the agent will be registered: 

a. Specify the host name or IP address of the machine where the management server is 
installed. 

b. Specify credentials of a management server administrator. You can use the current Windows 
session credentials or explicitly specify the user name and password.  

If you are logged on not as a management server administrator, you still can register the 
machine, by leaving the default Connect to the management server as option. 

c. Click Done. 

7. If prompted, select whether the machine with the agent will be added to the organization or to 
one of the units. 
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This prompt appears if you administer more than one unit, or an organization with at least one 
unit. Otherwise, the machine will be silently added to the unit you administer or to the 
organization. For more information, refer to "Administrators and units" (p. 232). 

8. Proceed with the installation. 

9. After the installation completes, click Close. 

10. If you installed Agent for Exchange, you will be able to back up Exchange databases. If you want 
to back up Exchange mailboxes, open the backup console, click Add > Microsoft Exchange Server 
> Exchange mailboxes, and then specify the machine where the Client Access server role (CAS) of 
Microsoft Exchange Server is enabled. For more information, refer to "Mailbox backup" (p. 161). 

To install Agent for VMware (Windows), Agent for Office 365, Agent for Oracle, or Agent for 
Exchange on a machine without Microsoft Exchange Server 

1. Log on as an administrator and start the Acronis Backup setup program. 

2. [Optional] To change the language the setup program is displayed in, click Setup language. 

3. Accept the terms of the license agreement and select whether the machine will participate in the 
Acronis Customer Experience Program (CEP). 

4. Select Install a backup agent, and then click Customize installation settings. 

5. Next to What to install, click Change. 

6. Select the check box corresponding to the agent that you want to install. Clear the check boxes 
for the components that you do not want to install. Click Done to continue. 

7. Specify the management server where the agent will be registered: 

a. Next to Acronis Backup Management Server, click Specify.  

b. Specify the host name or IP address of the machine where the management server is 
installed. 

c. Specify credentials of a management server administrator. You can use the current Windows 
session credentials or explicitly specify the user name and password.  

If you are logged on not as a management server administrator, you still can register the 
machine, by leaving the default Connect to the management server as option. 

d. Click Done. 

8. If prompted, select whether the machine with the agent will be added to the organization or to 
one of the units. 

This prompt appears if you administer more than one unit, or an organization with at least one 
unit. Otherwise, the machine will be silently added to the unit you administer or to the 
organization. For more information, refer to "Administrators and units" (p. 232). 

9. [Optional] Change other installation settings as described in "Customizing installation settings" (p. 
27). 

10. Click Install to proceed with the installation. 

11. After the installation completes, click Close. 

12. [Only when installing Agent for VMware (Windows)] Perform the procedure described in the 
"Registering an already installed Agent for VMware" (p. 32) section. 

13. [Only when installing Agent for Exchange] Open the backup console, click Add > Microsoft 
Exchange Server > Exchange mailboxes, and then specify the machine where the Client Access 
server role (CAS) of Microsoft Exchange Server is enabled. For more information, refer to 
"Mailbox backup" (p. 161). 
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2.6.3.2 Installation in Linux  

Preparation 

1. Before installing the product on a system that does not use RPM Package Manager, such as an 
Ubuntu system, you need to install this manager manually; for example, by running the following 
command (as the root user): apt - get install rpm . 

2. Ensure that the necessary Linux packages (p. 20) are installed on the machine. 

Installation 

To install Agent for Linux 

1. As the root user, run the appropriate installation file (an .i686 or an .x86_64 file). 

2. Accept the terms of the license agreement. 

3. Clear the Acronis Backup Management Server check box, and then click Next. 

4. Specify the host name or IP address of the machine where the management server is installed. 

5. Click Next to proceed with the installation. 

6. After the installation completes, click Exit. 

Troubleshooting information is provided in the file: 
/usr/lib/Acronis/BackupAndRecovery/HOWTO.INSTALL 
 

2.6.3.3 Installation in OS X 

To install Agent for Mac 

1. Double-click the installation file (.dmg). 

2. Wait while the operating system mounts the installation disk image. 

3. Double-click Install. 

4. Follow the on-screen instructions. 
 

2.6.3.4 Deploying Agent for VMware (Virtual Appliance) from an OVF 
template 

After the management server is installed, the virtual appliance's OVF package is located in the 
folder %ProgramFiles%\ Acronis\ ESXAppliance (in Windows) or /usr/lib/ Acronis/ESXAppliance (in 
Linux).  

The folder contains one .ovf file and two .vmdk files. Ensure that these files can be accessed from the 
machine running the vSphere Client. 

Deploying the OVF template 

1. Start the vSphere Client and log on to the vCenter Server. 

2. On the File menu, click Deploy OVF Template. 

3. In Source, specify the path to the virtual appliance's OVF package.  

4. Review the OVF Template Details and click Next. 

5. In Name and Location, type the name for the appliance or leave the default name of 
AcronisESXAppliance. 

6. In Host / Cluster, select the ESXi host that the appliance will be deployed to. 

7. [Optional] In Resource Pool, select the resource pool that will contain the appliance. 
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8. In Storage, leave the default datastore unless it does not have enough space for the virtual 
appliance. In this case, select another datastore. Skip this step if there is only one datastore on 
the server. 

9. In Disk Format, select any required value. The disk format does not affect the appliance 
performance. 

10. In Network mapping, select the bridged mode for the network adapter. 

11. Review the summary, and then click Finish. After the successful deployment is reported, close 
the progress window. 

Configuring the virtual appliance 

1. Starting the virtual appliance 

In the vSphere Client, display the Inventory, right-click the virtual appliance's name, and then 
select Power > Power On. Select the Console tab. On the welcome screen, click Close. 

2. vCenter/ESX(i) 

Under Agent options, in vCenter/ESX(i), click Change and specify the vCenter Server name or IP 
address. The agent will be able to back up and recover any virtual machine managed by the 
vCenter Server.  

If you do not use a vCenter Server, specify the name or IP address of the ESXi host whose virtual 
machines you want to back up and recover. Normally, backups run faster when the agent backs 
up virtual machines hosted on its own host.  

Specify the credentials that the agent will use to connect to the vCenter Server or ESXi. We 
recommend using an account that has the Administrator role assigned. Otherwise, provide an 
account with the necessary privileges (p. 193) on the vCenter Server or ESXi. 

You can click Check connection to ensure the access credentials are correct. 

3. Acronis Backup Management Server 

Under Agent options, in Acronis Backup Management Server, click Change.  

Specify the host name or IP address of the machine where the management server is installed, 
and the access credentials for that machine. 

4. Time zone 

Under Virtual machine, in Time zone, click Change. Select the time zone of your location to 
ensure that the scheduled operations run at the appropriate time. 

The virtual appliance is ready to work. In addition, you can change the following settings: 

Á Network settings 

The agent's network connection is configured automatically by using Dynamic Host Configuration 
Protocol (DHCP). To change the default configuration, under Agent options, in eth0, click Change 
and specify the desired network settings. 

Á Local storages 

You can attach an additional disk to the virtual appliance so the Agent for VMware can back up to 
this locally attached storage. This kind of backup is normally faster than a backup via LAN and it 
does not consume the network bandwidth.  

The virtual disk size must be at least 10 GB. Add the disk by editing the settings of the virtual 
machine and click Refresh. The Create storage link becomes available. Click this link, select the 
disk, and then specify a label for it. 

Be careful when adding an already existing disk. Once the storage is created, all data previously contained 
on this disk will be lost. 
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2.6.4 Managing licenses 

Licensing of Acronis Backup is based on the number of the backed-up physical machines and 
virtualization hosts. Both subscription and perpetual licenses can be used. A subscription expiration 
period starts when you register it on the Acronis site. 

To start using Acronis Backup, you need to add at least one license key to the management server. A 
license is automatically assigned to a machine when a backup plan is applied. 

Licenses can also be assigned and revoked manually. Manual operations with licenses are available 
only to organization administrators (p. 232). 

To add a license key 

1. Click Settings > Licenses. 

2. Click Add keys. 

3. Enter the license keys. 

4. Click Add. 

5. To activate a subscription, you must be signed in. If you entered at least one subscription key, 
enter the email address and password of your Acronis account, and then click Sign in. If you 
entered only perpetual keys, skip this step. 

6. Click Done. 

Tip   If you have already registered the subscription keys, the management server can import them from your 
Acronis account. To synchronize the subscription keys, click Sync and sign in. 

Managing perpetual licenses 

To assign a perpetual license to a machine 

1. Click Settings > Licenses. 

2. Select a perpetual license. 

The software displays the license keys that correspond to the selected license. 

3. Select the key to assign. 

4. Click Assign. 

The software displays the machines that the selected key can be assigned to. 

5. Select the machine, and then click Done. 

To revoke a perpetual license from a machine 

1. Click Settings > Licenses. 

2. Select a perpetual license. 

The software displays the license keys that correspond to the selected license. The machine that 
the key is assigned to is shown in the Assigned to column. 

3. Select the license key to revoke. 

4. Click Revoke. 

5. Confirm your decision. 

The revoked key will remain in the license keys list. It can be assigned to another machine. 

Managing subscription licenses 

To assign a subscription license to a machine 

1. Click Settings > Licenses. 

2. Select a subscription license. 



38 Copyright © Acronis International GmbH, 2002-2017 

 

The software displays the machines that the selected license is already assigned to. 

3. Click Assign. 

The software displays the machines that the selected license can be assigned to. 

4. Select the machine, and then click Done. 

To revoke a subscription license from a machine 

1. Click Settings > Licenses. 

2. Select a subscription license. 

The software displays machines that the selected license is already assigned to. 

3. Select the machine to revoke the license from. 

4. Click Revoke license. 

5. Confirm your decision. 
 

2.7 Cloud deployment 

2.7.1 Preparation 

Step 1 

Choose the agent, depending on what you are going to back up. For the information about the 
agents, refer to the "Components" (p. 11) section. 

Step 2 

Download the setup program. To find the download links, click All devices > Add. 

The Add devices page provides web installers for each agent that is installed in Windows. A web 
installer is a small executable file that downloads the main setup program from the Internet and 
saves it as a temporary file. This file is deleted immediately after the installation. 

If you want to store the setup programs locally, download a package containing all agents for 
installation in Windows by using the link at the bottom of the Add devices page. Both 32-bit and 
64-bit packages are available. These packages enable you to customize the list of components to 
install. These packages also enable unattended installation, for example, via Group Policy. This 
advanced scenario is described in "Deploying agents through Group Policy" (p. 41). 

Installation in Linux and OS X is performed from ordinary setup programs. 

All setup programs require an Internet connection to register the machine in the backup service. If 
there is no Internet connection, the installation will fail. 

Step 3 

Before the installation, ensure that your firewalls and other components of your network security 
system (such as a proxy sever) allow both inbound and outbound connections through the following 
TCP ports: 

Á 443 and 8443 These ports are used for accessing the backup console, registering the agents, 
downloading the certificates, user authorization, and downloading files from the cloud storage. 

Á 7770...7800 The agents use these ports to communicate with the backup management server. 

Á 44445 The agents use this port for data transfer during backup and recovery. 
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If a proxy server is enabled in your network, refer to the "Proxy server settings" (p. 39) section to 
understand whether you need to configure these settings on each machine that runs a backup agent. 
 

2.7.2 Proxy server settings 

The backup agents can transfer data through an HTTP proxy server. 

The agent installation requires an Internet connection. If a proxy server is configured in Windows 
(Control panel > Internet Options > Connections), the setup program reads the proxy server settings 
from the registry and uses them automatically. In Linux and OS X, you must specify the proxy settings 
before the installation. 

Use the procedures below to specify the proxy settings before the agent installation or to change 
them at a later time. 

In Linux 

1. Create the file /etc/Acronis/Global.config and open it in a text editor. 

2. Copy and paste the following lines into the file: 

<?xml version="1.0" ?>  
<registry name="Global">  
    <key name="HttpProxy">  
        <value name="Enabled" type="Tdword">"1"</value>  
        <value name="Host" type="TString">" proxy.company.com "</value>  
        <value name="Port" type="Tdword">" 443"</value>  
    </key>  
</registry>  

3. Replace proxy.company.com  with your proxy server host name/IP address, and 443 with the 
decimal value of the port number. 

4. Save the file. 

5. If the backup agent is not installed yet, you can now install it. Otherwise, restart the agent by 
executing the following command in any directory: 

sudo service acronis_mms rest art  

In OS X 

1. Create the file /Library/Application Support/Acronis/Registry/Global.config and open it in a 
text editor, such as Text Edit. 

2. Copy and paste the following lines into the file: 

<?xml version="1.0" ?>  
<registry name="Global">  
    <key name="HttpProxy">  
        <value name="Enabled" type="Tdword">"1"</value>  
        <value name="Host" type="TString">" proxy.company.com "</value>  
        <value name="Port" type="Tdword">" 443"</value>  
    </key>  
</registry>  

3. Replace proxy.company.c om with your proxy server host name/IP address, and 443 with the 
decimal value of the port number. 

4. Save the file. 

5. If the backup agent is not installed yet, you can now install it. Otherwise, do the following to 
restart the agent: 

a. Go to Applications > Utilities > Terminal 



40 Copyright © Acronis International GmbH, 2002-2017 

 

b. Run the following commands: 

sudo launchctl stop acronis_mms  
sudo launchctl start acronis_mms  

In Windows 

1. Create a new text document and open it in a text editor, such as Notepad. 

2. Copy and paste the following lines into the file: 

Windows Registry Editor Version 5.00  
 
[HKEY_LOCAL_MACHINE\ SOFTWARE\ Acronis \ Global \ HttpProxy]  
"Enabled"=dword:00000001  
"Host"=" proxy.company.com "  
"Port"=dword: 000001bb 

3. Replace proxy.company.com  with your proxy server host name/IP address, and 000001bb 
with the hexadecimal value of the port number. For example, 000001bb is port 443. 

4. Save the document as proxy.reg. 

5. Run the file as an administrator. 

6. Confirm that you want to edit the Windows registry. 

7. If the backup agent is not installed yet, you can now install it. Otherwise, do the following to 
restart the agent: 

a. In the Start menu, click Run, and then type: cmd 

b. Click OK. 

c. Run the following commands: 

net stop mms  
net start  mms 

 

2.7.3 Installing agents 

In Windows 

1. Ensure that the machine is connected to the Internet. 

2. Log on as an administrator and start the setup program. 

3. Click Install. 

4. Specify the credentials of the account to which the machine should be assigned. 

5. Click Show proxy settings if you want to verify or change the proxy server host name/IP address 
and port. Otherwise, skip this step. If a proxy server is enabled in Windows, it is detected and 
used automatically. 

6. [Only when installing Agent for VMware] Specify the address and access credentials for the 
vCenter Server or stand-alone ESXi host whose virtual machines the agent will back up. We 
recommend using an account that has the Administrator role assigned. Otherwise, provide an 
account with the necessary privileges (p. 193) on the vCenter Server or ESXi. 

7. [Only when installing on a domain controller] Specify the user account under which the agent 
service will run. For security reasons, the setup program does not automatically create new 
accounts on a domain controller. 

8. Click Start installation. 

You can change the installation path and the account for the agent service by clicking Customize 
installation settings on the first step of the installation wizard. 
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In Linux 

1. Ensure that the machine is connected to the Internet. 

2. As the root user, run the installation file. 

3. Specify the credentials of the account to which the machine should be assigned. 

4. Select the check boxes for the agents that you want to install. The following agents are available: 

Á Agent for Linux 

Á Agent for Virtuozzo 

Agent for Virtuozzo cannot be installed without Agent for Linux. 

5. Complete the installation procedure. 

Troubleshooting information is provided in the file: 
/usr/lib/Acronis/BackupAndRecovery/HOWTO.INSTALL 

In OS X 

1. Ensure that the machine is connected to the Internet. 

2. Double-click the installation file (.dmg). 

3. Wait while the operating system mounts the installation disk image. 

4. Double-click Install. 

5. If prompted, provide administrator credentials. 

6. Specify the credentials of the account to which the machine should be assigned. 

7. Complete the installation procedure. 
 

2.7.4 Activating the account 

When an administrator creates an account for you, an email message is sent to your email address. 
The message contains the following information: 

Á An account activation link. ˿ ƭƛŎƪ ǘƘŜ ƭƛƴƪ ŀƴŘ ǎŜǘ ǘƘŜ ǇŀǎǎǿƻǊŘ ŦƻǊ ǘƘŜ ŀŎŎƻǳƴǘΦ wŜƳŜƳōŜǊ ȅƻǳǊ 
login that is shown on the account activation page. 

Á A link to the backup console login page. Use this link to access the console in future. The login 
and password are the same as in the previous step. 

 

2.8 Deploying agents through Group Policy 
You can centrally install (or deploy) Agent for Windows onto machines that are members of an Active 
Directory domain, by using Group Policy.  

In this section, you will find out how to set up a Group Policy object to deploy agents onto machines 
in an entire domain or in its organizational unit. 

Every time a machine logs on to the domain, the resulting Group Policy object will ensure that the 
agent is installed and registered. 

Prerequisites 

Before proceeding with agent deployment, ensure that: 

Á You have an Active Directory domain with a domain controller running Microsoft Windows 
Server 2003 or later. 

Á You are a member of the Domain Admins group in the domain. 
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Á You have downloaded the All agents for installation in Windows setup program. The download 
link is available on the Add devices page in the backup console. 

Step 1: Creating the .mst transform and extracting the installation package 

1. Log on as an administrator on any machine in the domain. 

2. Create a shared folder that will contain the installation packages. Ensure that domain users can 
access the shared folderτfor example, by leaving the default sharing settings for Everyone. 

3. Copy the setup program to the folder you created. 

4. Start the setup program. 

5. Click Create .mst and .msi files for unattended installation. 

6. If prompted, specify the credentials of the account to which the machines should be assigned. 

7. Review or modify the installation settings that will be added to the .mst file. 

8. Click Generate. 

As a result, the .mst transform is generated and the .msi and .cab installation packages are extracted 
to the folder you created. You can now move or delete the setup program .exe file. 

Step 2: Setting up the Group Policy objects 

1. Log on to the domain controller as a domain administrator; if the domain has more than one 
domain controller, log on to any of them as a domain administrator. 

2. If you are planning to deploy the agent in an organizational unit, ensure that the organizational 
unit exists in the domain. Otherwise, skip this step. 

3. In the Start menu, point to Administrative Tools, and then click Active Directory Users and 
Computers (in Windows Server 2003) or Group Policy Management (in Windows Server 2008 
and Windows Server 2012). 

4. In Windows Server 2003: 

Á Right-click the name of the domain or organizational unit, and then click Properties. In the 
dialog box, click the Group Policy tab, and then click New. 

In Windows Server 2008 and Windows Server 2012: 

Á Right-click the name of the domain or organizational unit, and then click Create a GPO in this 
domain, and Link it here. 

5. Name the new Group Policy object Agent for Windows. 

6. Open the Agent for Windows Group Policy object for editing, as follows: 

Á In Windows Server 2003, click the Group Policy object, and then click Edit. 

Á In Windows Server 2008 and Windows Server 2012, under Group Policy Objects, right-click 
the Group Policy object, and then click Edit. 

7. In the Group Policy object editor snap-in, expand Computer Configuration. 

8. In Windows Server 2003 and Windows Server 2008: 

Á Expand Software Settings. 

In Windows Server 2012: 

Á Expand Policies > Software Settings. 

9. Right-click Software installation, then point to New, and then click Package. 

10. Select the agent's .msi installation package in the shared folder that you previously created, and 
then click Open. 

11. In the Deploy Software dialog box, click Advanced, and then click OK. 
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12. On the Modifications tab, click Add, and then select the .mst transform that you previously 
created. 

13. Click OK to close the Deploy Software dialog box. 
 

2.9 Updating agents 
Á On-premise deployment: to update the agents, first update the management server, and then 

repeat the agent installation locally or by using the web interface. 

Á Cloud deployment: the agents are updated automatically as soon as a new version is released. If 
an automatic update fails for any reason, use the procedure described below. 

To find the agent version, select the machine, and then click Details. 

To update an agent in a cloud deployment 

1. Click Settings > Agents. 

The software displays the list of machines. The machines with outdated agent versions are 
marked with an orange exclamation mark. 

2. Select the machines that you want to update the agents on. The machines must be online. 

3. Click Update agent. 

The update progress is shown in the status column for each machine. 
 

2.10 Uninstalling the product 
If you want to remove individual product components from a machine, run the setup program, 
choose to modify the product, and clear the selection of the components that you want to remove. 
The links to the setup programs are present on the Downloads page (click the account icon in the 
top-right corner > Downloads). 

If you want to remove all of the product components from a machine, follow the steps described 
below.  

Warning  In on-premise deployments, please do not uninstall the management server by mistake. The backup 
console will become unavailable. You will no longer be able to back up and recover all machines that are 
registered on the management server. 

In Windows 

1. Log on as an administrator. 

2. Go to Control panel, and then select Programs and Features (Add or Remove Programs in 
Windows XP) > Acronis Backup > Uninstall. 

3. [Optional] Select the Remove the logs and configuration settings check box. 

Keep this check box cleared if you are uninstalling an agent and are planning to install it again. If 
you select the check box, the machine may be duplicated in the backup console and the backups 
of the old machine may not be associated with the new machine. 

4. Confirm your decision. 

5. If you are planning to install the agent again, skip this step. Otherwise, in the backup console, 
click Settings > Agents, select the machine where the agent was installed, and then click Delete. 

In Linux 

1. As the root user, run /usr/lib/Acronis/BackupAndRecovery/uninstall/uninstall. 

2. [Optional] Select the Clean up all product traces (Remove the product's logs, tasks, vaults, and 
configuration settings) check box. 
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Keep this check box cleared if you are uninstalling an agent and are planning to install it again. If 
you select the check box, the machine may be duplicated in the backup console and the backups 
of the old machine may not be associated with the new machine. 

3. Confirm your decision. 

4. If you are planning to install the agent again, skip this step. Otherwise, in the backup console, 
click Settings > Agents, select the machine where the agent was installed, and then click Delete. 

In OS X 

1. Double-click the installation file (.dmg). 

2. Wait while the operating system mounts the installation disk image. 

3. Inside the image, double-click Uninstall. 

4. If prompted, provide administrator credentials. 

5. Confirm your decision. 

6. If you are planning to install the agent again, skip this step. Otherwise, in the backup console, 
click Settings > Agents, select the machine where the agent was installed, and then click Delete. 

Removing Agent for VMware (Virtual Appliance) 

1. Start the vSphere Client and log on to the vCenter Server. 

2. If the virtual appliance (VA) is powered on, right-click it, and then click Power > Power Off. 
Confirm your decision. 

3. If the VA uses a locally attached storage on a virtual disk and you want to preserve data on that 
disk, do the following: 

a. Right-click the VA, and then click Edit Settings. 

b. Select the disk with the storage, and then click Remove. Under Removal Options, click 
Remove from virtual machine. 

c. Click OK. 

As a result, the disk remains in the datastore. You can attach the disk to another VA. 

4. Right-click the VA, and then click Delete from Disk. Confirm your decision. 

5. If you are planning to install the agent again, skip this step. Otherwise, in the backup console, 
click Settings > Agents, select the virtual appliance, and then click Delete. 

 

3 Accessing the backup console 
To access the backup console, enter the login page address into the web browser address bar, and 
then sign in as described below. 

On-premise deployment 

The login page address is the IP address or name of the machine where the management server is 
installed. 

In Windows 

If the management server is installed in Windows, there are two ways to sign in to the backup 
console: 

Á ˿ƭƛŎƪ Sign in to sign in as the current Windows user.  

This is the easiest way to sign in from the same machine where the management server is 
installed. 
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If the management server is installed on a different machine, this method works on the 
conditions that: 

Á The machine you are signing in from is in the same Active Directory domain as the 
management server. 

Á You are logged on as a domain user. 

We recommend configuring your web browser for Integrated Windows Authentication (p. 45). 
Otherwise, the browser will ask for a user name and password. 

Á ˿ƭƛŎƪ Enter user name and password, and then specify the user name and password. 

In any case, your account must be in the list of the management server administrators. By default, 
this list contains the Administrators group on the machine running the management server. For 
more information, refer to "Administrators and units" (p. 232). 

In Linux 

If the management server is installed in Linux, specify the user name "root" and the password of the 
root user. 

Cloud deployment 

The login page address is https://backup.acronis.com/. The user name and password are those of 
your Acronis account. 

If your account was created by the backup administrator, you need to activate the account and set 
the password by clicking the link in your activation email. 

Changing the language 

When logged in, you can change the language of the web interface by clicking the account icon in the 
top-right corner. 
 

3.1 Configuring a web browser for Integrated Windows 
Authentication 

Integrated Windows Authentication is possible if you access the backup console from a machine 
running Windows and any supported browser (p. 13). 

We recommend configuring your web browser for Integrated Windows Authentication. Otherwise, 
the browser will ask for a user name and password. 

Configuring Internet Explorer, Microsoft Edge, Opera, and Google Chrome 

If the machine running the browser is in the same Active Directory domain as the machine running 
the management server, add the console's login page to the list of Local intranet sites. 

Otherwise, add the console's login page to the list of Trusted sites and enable the Automatic logon 
with current user name and password setting. 

The step-by-step instructions are provided later in this section. Because these browsers use Windows 
settings, it is also possible to configure them by using Group Policy in an Active Directory domain. 

Configuring Mozilla Firefox 

1. In Firefox, navigate to the URL about:config , and then click the I accept the risk button. 

2. In the Search field, search for the network.negotiate - auth.trusted - uris  preference. 



46 Copyright © Acronis International GmbH, 2002-2017 

 

3. Double-click the preference, and then enter the address of the backup console login page. 

4. Repeat steps 2-3 for the network.automatic - ntlm - auth.trusted - uris  preference. 

5. Close the about:config  window. 
 

3.1.1 Adding the console to the list of local intranet sites  
1. Go to Control Panel > Internet Options. 

2. On the Security tab, select Local intranet. 

 
3. Click Sites. 
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4. In Add this website to the zone, enter the address of the backup console login page, and then 
click Add. 

 
5. Click Close. 

6. Click OK. 
 

3.1.2 Adding the console to the list of trusted sites  
1. Go to Control Panel > Internet Options. 
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2. On the Security tab, select Trusted sites, and then click Custom Level. 
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3. Under Logon, select Automatic logon with current user name and password, and then click OK. 

 
4. On the Security tab, with Trusted sites still selected, click Sites. 

5. In Add this website to the zone, enter the address of the backup console login page, and then 
click Add. 
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6. Click Close. 

7. Click OK. 
 

4 Backup console views 
The backup console has two views: a simple view and a table view. To switch between the views, 
click the corresponding icon in the top right corner. 

The simple view supports a small number of machines. 

 

The table view is enabled automatically when the number of machines becomes large. 

 

Both views provide access to the same features and operations. This document describes access to 
operations from the table view. 
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5 Backup 
A backup plan is a set of rules that specify how the given data will be protected on a given machine. 

A backup plan can be applied to multiple machines at the time of its creation, or later. 

To create the first backup plan 

1. Select the machines that you want to back up. 

2. Click Backup. 

The software displays a new backup plan template. 

 
3. [Optional] To modify the backup plan name, click the default name. 

4. [Optional] To modify the plan parameters, click the corresponding section of the backup plan 
panel. 

5. [Optional] To modify the backup options, click the gear icon. 

6. Click Create. 

To apply an existing backup plan 

1. Select the machines that you want to back up. 

2. Click Backup. If a common backup plan is already applied to the selected machines, click Add 
backup plan. 
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The software displays previously created backup plans. 

 
3. Select a backup plan to apply. 

4. Click Apply. 
 

5.1 Backup plan cheat sheet 
Important  Some of the features described in this section were introduced in version 12.5, which affects only 
on-premise deployments. These features are not yet available in cloud deployments. For more information, refer 
to "What's new in Acronis Backup 12.5" (p. 7). 

The following table summarizes the available backup plan parameters. Use the table to create a 
backup plan that best fits your needs. 

WHAT TO BACK UP 
ITEMS TO BACK UP  

Selection methods 

WHERE TO BACK 
UP 

SCHEDULE 

Backup schemes 

 (not for Cloud) 

HOW LONG TO KEEP 

Disks/volumes 
(physical machines) 

Direct selection (p. 56) 
Policy rules (p. 56) 
File filters (p. 87) 

Cloud (p. 59) 
Local folder (p. 

59) 
Network folder 

(p. 59) 
SFTP server (p. 

59)*  
NFS (p. 59)*  

Secure Zone (p. 
59)*  

Managed 
location (p. 59)*  
Tape device (p. 

59)*  

Always incremental 
(Single-file) (p. 63)*  
Always full (p. 63) 
Weekly full, Daily 

incremental (p. 63) 
Monthly full, Weekly 

differential, Daily 
incremental (GFS) (p. 

63) 
Custom (F-D-I) (p. 63) 

By backup age 
(single rule/per 

backup set) (p. 69) 
By number of 

backups (p. 69) 
By total size of 

backups (p. 69)*  
Keep indefinitely (p. 

69) 
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Disks/volumes 
(virtual machines) 

Policy rules (p. 56) 
File filters (p. 87) 

Cloud (p. 59) 
Local folder (p. 

59) 
Network folder 

(p. 59) 
SFTP server (p. 

59)*  
NFS (p. 59)*  
Managed 

location (p. 59)*  
Tape device (p. 

59)*  

Files (physical 
machines only) 

Direct selection (p. 55) 
Policy rules (p. 55) 
File filters (p. 87) 

Cloud (p. 59) 
Local folder (p. 

59) 
Network folder 

(p. 59) 
SFTP server (p. 

59)*  
NFS (p. 59)*  

Secure Zone (p. 
59)*  

Managed 
location (p. 59)*  
Tape device (p. 

59) 

Always full (p. 63) 
Weekly full, Daily 

incremental (p. 63) 
Monthly full, Weekly 

differential, Daily 
incremental (GFS) (p. 

63) 
Custom (F-D-I) (p. 63) 

ESXi configuration Direct selection (p. 59) 

Local folder (p. 
59) 

Network folder 
(p. 59) 

SFTP server (p. 
59) 

NFS (p. 59)*  

System state (in 
cloud deployments 

only) 
Direct selection (p. 56) 

Cloud (p. 59) 
Local folder (p. 

59) 
Network folder 

(p. 59) 

Always full (p. 63) 
Weekly full, daily 

incremental (p. 63) 
Custom (F-I) (p. 63) 

SQL databases Direct selection (p. 156) 

Cloud (p. 59) 
Local folder (p. 

59) 
Network folder 

(p. 59) 
Managed 

location (p. 59)*  
Tape device (p. 

59) 

Exchange databases Direct selection (p. 156) 

Exchange mailboxes Direct selection (p. 161) 

Cloud (p. 59) 
Local folder (p. 

59) 
Network folder 

(p. 59) 

Always incremental 
(Single-file) (p. 63) 



54 Copyright © Acronis International GmbH, 2002-2017 

 

Office 365 
mailboxes 

Direct selection (p. 172) 

Managed 
location (p. 59)*  

By backup age 
(single rule/per 

backup set) (p. 69) 
By number of 

backups (p. 69) 
Keep indefinitely (p. 

69) 

* See the limitations below. 

Limitations 

SFTP server and tape device 

Á These locations cannot be a destination for disk-level backups of machines running macOS. 

Á These locations cannot be a destination for application-aware backups. 

Á The Always incremental (single-file) backup scheme is not available when backing up to these 
locations. 

Á The By total size of backups retention rule is not available for these locations. 

NFS 

Á Backup to NFS shares is not available in Windows. 

Secure Zone 

Á Secure Zone cannot be created on a Mac. 

Managed location 

Á A managed location cannot be a destination if the backup scheme is set to Always incremental 
(single-file) and encryption is enabled in the backup plan. 

Á A managed location with enabled deduplication or encryption cannot be selected as the 
destination: 

Á If the backup scheme is set to Always incremental (single-file)  

Á If the backup format is set to Version 12 

Á For disk-level backups of machines running macOS 

Á For backups of Exchange mailboxes and Office 365 mailboxes. 

Á The By total size of backups retention rule is not available for a managed location with enabled 
deduplication. 

Always incremental (single-file) 

Á The Always incremental (single-file) backup scheme is not available when backing up to an SFTP 
server or a tape device. 

By total size of backups 

Á The By total size of backups retention rule is not available: 

Á If the backup scheme is set to Always incremental (single-file)  

Á When backing up to an SFTP server, a tape device, or a managed location with enabled 
deduplication. 
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5.2 Selecting data to back up 

5.2.1 Selecting files/folders 

File-level backup is available only for physical machines. 

A file-level backup is not sufficient for recovery of the operating system. Choose file backup if you 
plan to protect only certain data (the current project, for example). This will reduce the backup size, 
thus saving storage space. 

There are two ways of selecting files: directly on each machine or by using policy rules. Either 
method allows you to further refine the selection by setting the file filters (p. 87). 

Direct selection 

1. In What to back up, select Files/folders. 

2. Click Items to back up. 

3. In Select items for backup, select Directly.  

4. For each of the machines included in the backup plan: 

a. Click Select files and folders. 

b. Click Local folder or Network folder. 

The share must be accessible from the selected machine. 

c. Browse to the required files/folders or enter the path and click the arrow button. If 
prompted, specify the user name and password for the shared folder. 

d. Select the required files/folders. 

e. Click Done. 

Using policy rules 

1. In What to back up, select Files/folders. 

2. Click Items to back up. 

3. In Select items for backup, select Using policy rules. 

4. Select any of the predefined rules, type your own rules, or combine both.  

The policy rules will be applied to all of the machines included in the backup plan. If no data 
meeting at least one of the rules is found on a machine when the backup starts, the backup will 
fail on that machine. 

5. Click Done. 

Selection rules for Windows 

Á Full path to a file or folder, for example D:\ Work\ Text.doc or C:\ Windows. 

Á Templates: 

Á [All Files]  selects all files on all volumes of the machine. 

Á [All Profiles Folder]  selects the folder where all user profiles are located (typically, 
C:\ Users or C:\ Documents and Settings). 

Á Environment variables: 

Á %ALLUSERSPROFILE% selects the folder where the common data of all user profiles is 
located (typically, C:\ ProgramData or C:\ Documents and Settings\ All Users). 

Á %PROGRAMFILES% selects the Program Files folder (for example, C:\ Program Files). 

Á %WINDIR% selects the folder where Windows is located (for example, C:\ Windows). 
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You can use other environment variables or a combination of environment variables and text. For 
example, to select the Java folder in the Program Files folder, type: %PROGRAMFILES%\ Java. 

Selection rules for Linux 

Á Full path to a file or directory. For example, to back up file.txt  on the volume /dev/hda3 
mounted on /home/usr/docs, specify /dev/hda3/file.txt  or /home/usr/docs/file.txt . 

Á /home selects the home directory of the common users. 

Á /root  selects the root user's home directory. 

Á /usr  selects the directory for all user-related programs. 

Á /etc  selects the directory for system configuration files. 

Á Templates: 

Á [All Profiles Folder]  selects /home. This is the folder where all user profiles are 
located by default. 

Selection rules for OS X 

Á Full path to a file or directory. 

Á Templates: 

Á [All Profiles Folder]  selects /Users. This is the folder where all user profiles are 
located by default. 

Examples: 

Á To back up file.txt  on your desktop, specify /Users/<username>/Desktop/file.txt, where 
<username> is your user name. 

Á To back up all users' home directories, specify /Users. 

Á To back up the directory where the applications are installed, specify /Applications. 
 

5.2.2 Selecting system state 

System state backup is available for machines running Windows Vista and later. 

To back up system state, in What to back up, select System state. 

A system state backup is comprised of the following files: 

Á Task scheduler configuration 

Á VSS Metadata Store 

Á Performance counter configuration information 

Á MSSearch Service 

Á Background Intelligent Transfer Service (BITS) 

Á The registry 

Á Windows Management Instrumentation (WMI) 

Á Component Services Class registration database 
 

5.2.3 Selecting disks/volumes 

A disk-level backup contains a copy of a disk or a volume in a packaged form. You can recover 
individual disks, volumes, or files from a disk-level backup. A backup of an entire machine is a backup 
of all its disks. 




















































































































































































































































































































































































